Agresso
Unit 4 Business World
Desktop
Enquiry & Reporting
CONTENTS

Agresso M7 Log-in ................................................................................................................. 3
Browser Enquiry Information................................................................................................. 3
Balance Tables ..................................................................................................................... 3
Data Warehouse .................................................................................................................. 4
Financial Reports & Enquiries ............................................................................................. 4
Setup tab ............................................................................................................................... 5
  Adding and Deleting Fields ............................................................................................... 6
  Show column ..................................................................................................................... 7
Subtotal and Sort ................................................................................................................... 7
Adding a relation ................................................................................................................... 8
Attribute ............................................................................................................................... 8
Relation .................................................................................................................................. 8
Formatting Results ............................................................................................................... 9
SearchC tab .......................................................................................................................... 10
  Relevant options – Type .................................................................................................... 11
  Adding/Deleting Search Criteria ....................................................................................... 12
Running a Report with Prompts ........................................................................................... 13
Running a report without prompts ...................................................................................... 14
Results Tab .......................................................................................................................... 14
  Using the Filter ................................................................................................................... 15
  Saving a Browser Template ............................................................................................... 16
Using Enquiry Results outside Agresso .............................................................................. 18
For smaller datasets Copy and Paste to an Excel Spreadsheet ............................................ 18
File/Save as ......................................................................................................................... 18
Master File Enquiries ........................................................................................................... 20
Financial Transaction Enquiries .......................................................................................... 21
  Zoom screens .................................................................................................................... 21
Running Excelerator reports ............................................................................................... 22
Maintenance of ordered reports ......................................................................................... 23
  Useful Tips ........................................................................................................................ 25
Agresso M7 Log-out ............................................................................................................. 26
Appendix 1 – University Accounting Periods ...................................................................... 27
Agresso Unit 4 Business World - Desktop - Enquiry & Reporting

**Agresso M7 Log-in**

Double-clicking the shortcut icon will launch the Unit 4 Business World login screen:

![Login Screen]

**Hint:** Use the Tab key to move between fields

If you forget your IT password, please visit the York Identity Manager at [My IT Account](https://www.york.ac.uk/univ/mis/cfm/authreg/start.cfm) online to manage your password and follow the instructions to reset this yourself, or use the [IT Services Helpdesk](https://www.york.ac.uk/univ/mis/cfm/authreg/start.cfm).

If you don’t already have an Agresso account, create a request via the online Authorised Systems Registration System at [https://www.york.ac.uk/univ/mis/cfm/authreg/start.cfm](https://www.york.ac.uk/univ/mis/cfm/authreg/start.cfm)

**Browser Enquiry Information**

Browser enquiries can be based upon

- **Financial data**, either summarised or on a transaction basis, or
- **Masterfile data**

Browser enquiries can be used within most areas of Agresso Desktop and the results can be filtered, sorted, sub-totalled and exported or copied to Excel.

**Financial summary** information is held in either **Balance Tables** or **Data Warehouses**.

**Balance Tables**

A balance table is a summary of transaction values by

- Account code,
- Project code,
- Analysis code, and
- Period date

They are updated centrally on a periodic basis and make reporting and enquiries faster, because fewer records are queried from a balance table than from transaction tables.
Balance tables also hold budget information, so any report or enquiry that includes budget amounts must be based upon a balance table.

Data Warehouse

A data warehouse is a “snapshot” view of a balance table taken at the end of a period.

Data warehouses are similar in setup to a balance table, but include further useful information such as expenditure to date and budget to date.

Data warehouses are used primarily for standard monthly summary reports, using Excelerator, and also as on screen browser enquiries.

Transaction enquiries can take longer to run than financial summary enquiries, because the system is searching through a large table of transactions to retrieve the requested results.

It is very important when running transaction based enquiries to ensure that search criteria fields are completed and the use of wildcards * kept to a minimum to help speed up the enquiry process.

Financial Reports & Enquiries

Financial Reports can be found on the Reports Menu | Global Reports

Choose a Report by clicking on the link to open a new enquiry screen. For example, Year to Date Project WO & Analysis report is based upon a data warehouse. This is indicated by the period selected below the balance table name on the Setup tab.
If an enquiry is based upon a balance table, rather than a data warehouse, the date field is blank.

The browser enquiry screen has three tabs:
- Setup
- SearchC
- Results

**Setup tab**

**Items to note on the Setup tab**
- Balance table name
- Period date
- Template name - you can select other templates but you must remember to TAB out of the field to refresh the screen with the new column headings
- Column headings – shown on the report

You may add or delete column names to refine the report to your own needs. You may also create your own templates eliminating the need to redesign a new template each time you want to run the same report.
Adding and Deleting Fields

To add column names place the cursor in the field that you wish to appear after your new column name and click once on the right hand mouse button. Select **Add field** from the drop-down list.

To delete column names, place your cursor in the column heading you wish to delete and click once on the right hand mouse button. Select **Delete field** from the drop-down list.

Nb. If you select **Delete all fields** you will delete all column headings regardless of where your cursor is placed within the template.

You can also use the Tools options which are available from the main tool bar or across the top of the browser screen.

The **Tools menu options** also display across the top of the browser screen.

The **direction arrows** allow you to arrange the column names in the order you require to see them on the Results screen and, subsequently, on a report. To re-arrange, highlight the **column name** to be moved, then click on the appropriate arrow.
Show column

Show column allows you to change the way you view the information on the report, see example below:

- **Code** = 4 digit number
- **Text** = description of the code
- **Code/Text** = 4 digit code and text shown in 2 separate columns
- **Text/Code** = text and 4 digit code shown in 2 separate columns
- **Join-column** = if you include data from a field but do not wish to display it on the report, choose this option.

**Hints!** You would use the Join-Column option if you want to add a relation to the selection criteria, for example, Dept is a relation on both Project and Workorder. You would not be able to run the report for Dept without including either Project or Workorder on the Setup tab. But you can join-column if you do not wish to see the Project or Workorder printed on every report line.

Subtotal and Sort
You can use the **Subtotal** and **Sort** columns to refine the report.

For example, if you mark the **Subtotal** box relating to Workorder, a grey total line in the report shows the total value for each Workorder.

If you also enter a number 1 in the **Sort** column against Workorder, Agresso sorts the Results for each Workorder, by sorting and placing together all the rows relating to the same code.

**Tip:** Sort and subtotal on more than one column at a time. For example you might want to sort by Workorder (1), but you also might want to sort within that Workorder by account type or Repord (2) as shown on the example above.

**Adding a relation**

**Attribute**
Most pieces of data held within Agresso are called attributes such as project, account, project manager (PI), department, etc.

After information has been categorised into attributes, links between related categories of information may then be made.

**Relation**
Relations are connections between attributes. For example, Project relations are used to:

- build report structures between project and report attributes.
- connect additional information to the project.

This means it is possible to report transactions at department level without the need to identify the department on every transaction, as each project is related to a department. Attributes and relations allow you to interrogate the system and create effective management reports.

To add a **Relation** place your cursor onto the attribute for which the relation exists.

**Click on the right hand mouse button and select Add Relation**

**Select a Relation from the list available then click OK.**
You have now added a new column, with the selected relation placed above the highlighted attribute.

Formatting Results
You can amend the format of the results by right clicking on the Setup tab and selecting Properties.

The Start detail level defines the level of the report within the Results tab. There are 3 levels:

0 = standard/lowest level, e.g. within a transaction report the results will show every transaction line with subtotal and total lines, for example:

1 = a higher level e.g. will collapse the results to the subtotal level with the facility to expand to the transaction level, for example:
2 = a higher level e.g. this collapses the report results to give the grand total. The user can expand the results up to the subtotal and transaction levels and back again by using the VCR buttons on the main menu.

The results screen can show budget, expenditure, commitments, spend and variance for the period. Results can be expanded to see a summary at account code level.

**SearchC tab**

Search parameters are used to restrict the enquiry results to the information you want to see on your report. It is necessary to narrow down your search by entering search parameters. If search parameters are not entered most enquiries would timeout before completion or the volume of information retrieved would be unmanageable.

Search conditions can be placed on any column in the search.

A column does not need to be displayed on the Setup tab for you to place restrictions on it. e.g. a report run for only one project, does not require the project to be displayed for every row. On the example below, Project is, therefore, included as Join-column:-
On the SearchC tab, the **Type** column is used to define the manner in which you want Agresso to use the search criteria you specify in the **Value** column, which will limit your search.

In the **Value** column, enter the **Project and Workorder**, upon which you wish to restrict the search.

If the check box in the **P (Prompt)** column is clicked on, the user running the enquiry will be prompted to enter these values when they select the find option.

Leave the check box blank if you want to “hard code” the search criterion.

**Relevant options – Type**

<table>
<thead>
<tr>
<th>Options</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Like</td>
<td>Allows you to specify a value or a range of alphanumeric values (includes using * as a wildcard) in the Value-column</td>
</tr>
<tr>
<td>Not like</td>
<td>Excludes the values you specify in the Value-column</td>
</tr>
<tr>
<td>Between</td>
<td>Enables you to specify from/to alphanumeric values between which Agresso will</td>
</tr>
</tbody>
</table>
display a range of transactions

<table>
<thead>
<tr>
<th>Not between</th>
<th>Excludes the values that you specify in the Value-column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater than or equal to/Less than or equal to</td>
<td>Allows you to specify a value greater than or less than or equal to a certain value. The screenshot above shows a way of selecting a range of periods by specifying two lines (Period) and using Greater than or equal to and Less than or equal to in order to restrict the report to a range of periods</td>
</tr>
<tr>
<td>Greater than/Less than</td>
<td>Offers the same functionality as the ones above, except for leaving out the value from/to in the result</td>
</tr>
<tr>
<td>In list/Not in list</td>
<td>Allows you to pick and choose existing attribute values from a list, providing more advanced results than the ranges from/to generally return. When you select In list the first time, Agresso displays the full list when you tab out:</td>
</tr>
</tbody>
</table>

Select the values to use in the search condition by highlighting them in the left-hand column (can also use Shift and Ctrl for multiple values), then press the right arrow button to move them over to the right-hand column. OK brings them into the Value column on the SearchC tab.

Alternatively, enter required values directly in the Value column, using single quotes and commas to separate them:

If you need to amend the selected selection criteria, use the right-click (or use Tools) on the SearchC row that includes an In list Type and click Search conditions:

Adding/Deleting Search Criteria

Click on the SearchC tab. Position the mouse in the dark grey area below the Column names. Click the right hand mouse button then click the option to Add Field.

Choose search conditions from the list:
Useful Tips!
Hold the **Shift** or **Control** keys to make multiple selections. **Shift** selects a **block**; **Control** (Ctrl) selects **individual** items.

The same column name can be used more than once in search criteria. Once you have made your selection click on OK.

**Important!**
*Never leave a Value field blank as it will take Agresso longer to retrieve your results.*

Running a Report with Prompts
If the prompt (P) field on the SearchC tab is marked you will be prompted to complete the appropriate search criteria pop-up boxes before running the enquiry, for example, when you click on the binoculars (F7) to run the report, the prompt boxes open:

Marked Prompts will activate a **pop-up box** where search parameters can be entered or changed prior to running the report.

Complete blank fields in the **pop-up boxes** to produce your results.

Complete blank fields in the **pop-up boxes** or change your search parameters, then click OK to continue to run the enquiry.

Useful Tips!
If you wish to restrict your results to one Workorder under a Project, enter a single Workorder.

Entering a wildcard (*) in the Workorder Value field would retrieve all workorders unless results are also restricted by Project, in which case, results are limited to the Workorders relating to just that one Project.
Running a report without prompts
Before you run an enquiry without the prompt (P) column marked, you must enter search criteria into the SearchC tab.

Enter search criteria into the Value column. **Do not leave any of the value columns blank.** If you do not wish to enter any criteria against a field heading, highlight then delete that line by using the right hand mouse function.

Once search criteria have been added, click on the binoculars (F7) to run your enquiry.

Results Tab

The Results Tab shows the results of your enquiry based on the selection criteria you entered on the SearchC tab; these results are sorted and sub-totalled as specified on the Setup tab, for example:
Agresso Unit 4 Business World - Desktop - Enquiry & Reporting

With sub-totals applied to your report template you can easily condense the results by clicking on the left-hand VCR arrows on the main Agresso menu. To expand results and to view the full list of results, click on the right-hand VCR arrows:

Use VCR arrows to navigate through your enquiry results.

Using the Filter

If results unexpectedly produce many lines of data without specifying a restriction on the SearchC tab, use the Filter functionality to concentrate on specific information:

Use the Filter to view specific information

For example, results above are now filtered by Account 2205
Tip! If you wish to view all results once more, you must re-run the enquiry by clicking on the Binoculars (F7).

Saving a Browser Template
An amended template can be saved to the Agresso server so that you can use it again without the need to re-configure search criteria each time.

Please note – templates will be saved as a private template, access is restricted to yourself. Only system administrators are authorised to save global templates for all users to access.

- Once configured, to save a template, click on the Setup tab.
- Select File then Save as from the dropdown list

Select Template File then click the OK button
- Enter a unique name for your template within the Description field – it’s good practice to use your UserID at the start of the description as shown below:

- Ensure the radio button Private is checked
- If you would like the report to find the results immediately as you open the template then click in the box to mark the Find Automatically field
- If you are saving changes to an existing template, also check the radio button Overwrite
- Click the OK button
Click **Yes** on the **Update menu** pop-up box.

Your own private templates can now easily be retrieved via the Search menu function using your userid in the search text box, for example:-
Using Enquiry Results outside Agresso

For smaller datasets Copy and Paste to an Excel Spreadsheet

Edit/Copy allows part or entire results to be copied into a spreadsheet. Select the entire Results by clicking the blank square situated above row 1 and to the left of the first column heading:

![Image of Excel spreadsheet]

Click to select entire results of enquiry

Edit on the Main Menu and select Copy, then open Excel, place the cursor in cell A1 and, with the right hand mouse function, select Paste:

![Image of Excel spreadsheet]

File/Save as

File/Save as also provides an option to save your results:
File formats | Function
--- | ---
Worksheet File (*.xls) | Saves results as an Excel worksheet. Once you save the file, Excel will automatically launch and display the results. If you wish to analyse the results, first run the enquiry without any sub-totals.

For larger datasets, use the Report Export function:

To do this, on the main Agresso menu, click the Reports icon then, from the pop-up box, select the appropriate format:

Agresso then opens Excel and displays the formatted results:
Master File Enquiries

Select the browser template you wish to run by double clicking on the magnifying glass next to the template name.

This enquiry enables you to search for a list of projects. The example results below are restricted by Department Description and Project Status N = Active.

If your Agresso role has sufficient access, double clicking on a project line opens the Project Master File for that project:

Also remember that the results you see are determined by your Agresso role access.
Financial Transaction Enquiries

Financial transaction enquiries are found within Agresso Financials | General Ledger | Enquiries | General Ledger transactions as shown below:

Transaction enquiries can take longer to run than financial summary enquiries because the system is searching through a data table of all transaction lines to retrieve specific results. It is, therefore, very important, when running transaction based enquiries, to ensure that all search criteria fields are completed correctly while the use of wildcards is kept to a minimum to help speed up the enquiry process. Even so, some Excelerator reports are much slower than many browser enquiries. See sample results below:

Zoom screens
On the results tab, Double click on a transaction to zoom to view further information on a transaction line, from the above example:

From the Tools menu select Invoice details
Within the zoom screen, and if you have the appropriate access, select **Invoice Details** from the Tools menu. This opens up a further zoom screen which shows the original invoice amount (**Curr.amount**) and the outstanding amount (**Rest curr.amount**).

**Useful Tip!** If Rest curr.amount is 0.00 then the invoice has been paid in full.

**Running Excelerator reports**

Agresso Excelerator is a reporting tool that presents its results in spreadsheet format, taking advantage of the functionality of Microsoft Excel.

Excelerator reports are used particularly for financial reporting and use Agresso balance tables or Browser enquiries as its source.

Excelerator reports developed via Excel, are run from the Agresso Personal Menu.

If your role has access to Excelerator reports, go to the **Personal Menu** item and expand the **Excelerator Reports** menu. Select the report you want to run from the list provided:-

In this example, the Rest curr.amount is shown as 0.00 therefore, this invoice has been paid.
Double click the report name to open a screen similar to the following example:-

Ignore all fields above the horizontal line (shown above row 11 in the example above). The fields below this line are the **selection criteria** to be completed *before* running the report.

1) In the example above, enter the required **Workorder** number on Row 14

2) Enter the “**Start Period**” and “**End Period**” values and the “**Report end period**” required for budget and expenditure to date values.

3) **Save** (F12) to run the report. A pop-up box appears giving you an order number which can identify your specific report in case of a problem, for example:-

![Order number image]

**Maintenance of ordered reports**

When your report is ready to view its **Status** changes from **W** to **T**, you can also see when your report has completed on the **ordered reports pane** at the foot of the main Agresso workspace. Status is Pending until the report completes:-

![Ordered reports pane image]

Once Finished, view your report results, this can be done either from the Ordered reports pane, double-click the report info line to open your report results in Excel.

Alternatively, from the **View menu** click on **Maintenance of ordered reports**:-
or click the icon on the Agresso main tool bar, this opens the Maintenance of ordered reports screen, your latest report is shown at the top of the list.

When your report Status has changed to T, double-click anywhere on your report line to open formatted results in Excel, for example:-

Just like the results of a browser enquiry, an Excelerator report in Excel can be viewed, emailed, saved etc as required.
Agresso Unit 4 Business World - Desktop - Enquiry & Reporting

Useful Tips
Using the screen **Maintenance of ordered reports** you can set up, maintain and enquire on the queue of reports and server processes, which have been ordered.

If you click on the **Binoculars (F7)** you will see a list of ordered reports running on different server queues, some awaiting execution, others in progress, or finished. The search can be restricted or made more general by changing the values in the search field ? on the grey bar:-

With the Maintenance of ordered reports screen (Agresso screen id CR16) open, click the Zoom command on the main menu; your report order parameters are shown in the zoom screen (Agresso screen id CR17). If your report still has a status of N you may, depending on your access level in Agresso, amend some of the order details such as the destination printer, server queue or the number of copies of the report. However, once the report has started running you can no longer make any changes.

**Report Status** can be
N = Awaiting Execution,
W = In Progress, or
T = Finished
Agresso M7 Log-out

To Close Agresso, click on the X button to close the workspace window then click Yes on the pop-up to confirm.
Appendix 1 – University Accounting Periods

University accounting periods are a six-digit number split into two parts.

The first part is the accounting year. University accounting year runs from 1st August to 31st July. The current accounting year of 2018 runs from August 2018 to July 2019.

The second part of the number relates to the month. August = 01 to July = 12.

Therefore the full six digits for each accounting month in the current accounting year are:-

<table>
<thead>
<tr>
<th>Account Period</th>
<th>Month</th>
</tr>
</thead>
<tbody>
<tr>
<td>201801</td>
<td>August 2018</td>
</tr>
<tr>
<td>201802</td>
<td>September 2018</td>
</tr>
<tr>
<td>201803</td>
<td>October 2018</td>
</tr>
<tr>
<td>201804</td>
<td>November 2018</td>
</tr>
<tr>
<td>201805</td>
<td>December 2018</td>
</tr>
<tr>
<td>201806</td>
<td>January 2019</td>
</tr>
<tr>
<td>201807</td>
<td>February 2019</td>
</tr>
<tr>
<td>201808</td>
<td>March 2019</td>
</tr>
<tr>
<td>201809</td>
<td>April 2019</td>
</tr>
<tr>
<td>201810</td>
<td>May 2019</td>
</tr>
<tr>
<td>201811</td>
<td>June 2019</td>
</tr>
<tr>
<td>201812</td>
<td>July 2019</td>
</tr>
</tbody>
</table>